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Updated GUI screenshot and text 

 

Overhaul 

Bea Tabuñar 11 July 2018 8.1.0 Updated colour definitions for Activity Panel > Flights 

tab 
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DISCLAIMER:   

This user guide is for training purposes only.  The information contained in this user guide is current at the time of 

publication.  It can be used to reference and may be subject to change. 
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What are merlot’s applications? 

The merlot.aero suite is a complete organizational management solution offering all aspects of airline resource planning 

and control to ensure the safety, efficiency and quality of your crew and operational environment.  

 

merlot.aero is a comprehensive suite of applications covering all aspects of your airline needs. It has been developed 

with the entire business process in mind, including the customer process from the moment ticket sales are planned until 

the point the passenger reaches their destination. 

 

For your convenience, merlot applications are divided into two main categories: 

• Aircraft Applications 

• Crew Applications 

 

There are a number of applications under these two main categories.   

 

Aircraft applications include: 

• AircraftSchedule   

• AircraftFollow 

• AircraftPortal 

• AircraftMobile 

 

Crew applications include: 

• CrewPlan 

• CrewBuild  

• CrewRoster  

• CrewPortal 

• CrewMonitor  

• CrewFollow   

• CrewPayroll 

• CrewMobile  
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FrameWork Applications 

The merlot.aero suite of applications eliminates the use of text commands by employing a Graphical User Interface (GUI). 

You are presented with the following options available in all applications across the merlot.aero suite. 

 

 
 

These are Framework Applications that will follow you throughout the merlot suite.   

 

This icon is the Job Engine .  If red, this means the job engine has stopped. If green, the job engine is running. 

 

 

This icon  is the signal strength of your connection to the Internet. 

 

The Memory Monitoring tool  displays memory utilization for merlot applications in real time.  

 

Memory utilization is displayed in three different levels: 

 

Icon Level Range 

 

 

 

Low (Green) 

 

 

0MB-700MB 

 

 

 

 

Moderate 

(Yellow) 

 

 

701MB - 1000MB 

 

 

 

 

High (Red) 

 

 

1001MB and above 

 

 

Hovering the mouse over the tool icon displays the following information: 

 

• Icon label - Memory Monitor 

• Memory consumption in MB with KB conversion e.g. 64 MB (65660 KB) 

• Level of memory consumption e.g. Low 
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This icon is Ad Hoc Reports . Ad hoc reports are available in all the applications and modules across the merlot.aero 

suite while specific application reports are available in the Reports dropdown menu. 

 

 

 
 

This icon is the Shift Log .  You can add notes to the Shift Log for any system user to view. 

 

 
  

This icon is to Add Task .  Set a daily or one-time reminder for everyday activities (i.e.: Accommodation Check). 

 

 

This is the send documents  icon. Send a document to a crew member or to a fellow merlot.aero user.   
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This is the mail  icon.  Send messages to crew or co-workers via SMS, email or directly within the merlot.aero 

suite. 

 

 

This icon allows you to navigate through the entire merlot.aero suite. 

 

 
 

When the application setting UseUIDebug is set to True, the New Activity Log menu will be visible under the Login Centre 

and available for use. All incoming Merlot UI Error Logs will not be displayed in the existing error log in the application nor 

trigger the alert unless the error is related to Insert/ Add/ Delete rows. 
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Example of a collapsed Activity Log form: 

 

 
 

When a user expands the log value, the complete details of the selected UI error log will be displayed. 
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Example of an expanded Activity Log form: 
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Logging into CrewBuild 

With your merlot.aero credentials simply log in and select CrewBuild. 
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What is CrewBuild? 

The CrewBuild application, along with CrewRoster, is used to develop efficient crew pairings and rosters that achieve 

business goals while meeting the needs of crew and managing changes that arise after the roster is published. 

 

The CrewBuild application enables the user to build pairings which are then assigned to crew member rosters in the 

CrewRoster application.  

 

Pairings are a generic unit of work and non-work that can be assigned to a crew member. A pairing is comprised of none, 

one or more flights and/or activities grouped together into one or more Duties. A pairing may span multiple days.  
 

CrewBuild Prerequisites 

Prior to undertaking tasks in CrewBuild, it is first necessary to define roster periods in the Configure application.  In the  

Configure application, you will name your roster period, determine the duration of the roster and select the department. In 

addition, you will select the rank or rank groups for the roster period. See the Configure User Manual for more detail on 

this process.   

 
Tasks in AircraftSchedule take place before action in CrewBuild. The user imports a Standard Schedules Information 

Manual (SSIM) or creates a new schedule. Once all the flights are in the schedule, the schedule is marked active. See the 

AircraftSchedule User Manual for more information. 

In the CrewFollow application, ad-hoc flights can also be created prior to action in CrewBuild. See the CrewFollow User 

Manual for more detail on this process. 
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The Graphical User Interface (GUI) 

The merlot.aero suite of applications eliminates the use of text commands by employing a Graphical User Interface 

(GUI). Let’s explore the CrewBuild GUI: 

 

 
 

1. Flight Gantt: Displays flight information graphically in a bar chart format. 

2. Activity Panel: List Pairings, Flights and Activities that can be allocated to the crew. 

3. Pairing Details Panel: View and modify the details of the pairings. 

 

1 

2 

3 
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Activity Panel 

The Activity Panel defines all the work. It contains lists of created pairings and lists of all the flights and activities that have 

been or can be incorporated into the pairings. The Activity Panel is used to view open, covered, and over-covered pairings 

and flights, to create new events and to assist in creating and amending pairings.   

 

 
 

To assign work to crew members, individual work activities should be grouped together into meaningful units of work and 

a list of available work then needs to be generated. This information is provided by the Activity Panel, which lists the work 

activities in the Flights and Events tabs, and then lists the created work in the Pairings and Standard Pairing tabs. 

 

Any changes made in the Activity Panel will require a re-filter to view them. To do this, simply click View.   
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Filtering 

The Activity Panel has an associated filter, which can be used to limit the activity information displayed to that which 

matches the filter criteria. To aid the user in determining how much work 

is required to be created and allocated, the Activity Panel contains filters 

that are applied to the data on the tabs. These filters allow the user to 

focus on particular sets of data and to view the data that has been 

created or allocated, and/or work still requiring creation or allocation. 

 

The Filter for the Activity Panel can be divided in the following sub-

sections: 

• Date and Time Filter 

• Save a Filter or re-use existing Saved Filter 

• Set Default Filter 

• Criteria for Filter 

• View the Data 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Date and Time  

In order to view crew data in the Activity Panel, users must load the data for a specified date range by entering a date 

range into the date control. A dropdown calendar is provided to select the date.  

 

• From - A date field. The start value of the date range  

• To - A date field. The end value of the date range  

• Save Dates - The selected date range will be the default date for the saved filter 

 

Note: The date controls throughout the merlot suite have built-in short-cuts. These shortcuts allow users to instantly select 

different date targets, such as the current day (T), or the start of a month (M), a quarter (Q) or a year (Y).  

 

Save Filter or Re-use an Existing Filter 

To allow users to specify and save filters, the Filter Section has a Filters field and associated Save, Delete and Reset icon 

buttons as well as a Save Dates checkbox.   
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The Filters field is a combination of a dropdown lists that displays the previously saved filters, as defined by the user, along 

with template filters that apply to all users. There is also the ability to enter a new filter name in the New Filter field and to 

click the plus (+) icon to add the new filter. 

 

The Save Dates check box allows the user to control whether a filter they define is set to a specific date time range or if 

the selected filter inherits the current date time range in the Monitoring Panel. 

Set as a Default Filter 

Part of the process when opening the Activity Panel, is to apply a default filter. This is to facilitate rapid filtering of displayed 

data to the data that the user refers to most frequently.    

 

To allow the user to set a default filter, the filter section contains a Default check box. When this button is clicked, the 

currently selected filter is saved as the default filter for the application.   

 

When the Activity Panel is opened, it determines the current user and the application context and defaults to the relevant 

filter.   

 

Criteria for Filter 

The Filter section contains the following criteria which are used to determine which data is displayed in tabs on the 

Activity Panel: 

 

Field Description 

Base A dropdown field that displays the active crew bases 

Rank A dropdown field that displays active ranks and / or rank groups 

Equip A dropdown field that displays the active aircraft or equipment types or groups that crew 
operate 

Pairing Type A dropdown field that displays the kinds of pairings to be displayed 

Operator The Operator dropdown menu filters the grid to show information based on selected airline 

operators 
 

Department A dropdown field that displays active departments. It is an area within an airline or company 
that is tasked with providing particular services of a similar type. For example, Flight 
Operations (i.e. the manning and operating of aircraft), Maintenance (ensure the aircraft are 

able to operate safely), Ramp (the parking and coordination of aircraft resupply between 
flights). 

Status Pairing status dropdown menu which includes All, Planned, Active, Provisionally Active 
options 

Retain layout on 
refresh 

This checkbox prevents the grid from returning to the default values. 

Open This checkbox indicates that the displayed data must include all open pairings or flights. 

Resulting pairings and flights are colored in white (no assignments yet) or light blue (partially 
covered) 
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Covered This checkbox indicates that the displayed data must include all covered pairings or flights. 
Resulting flights and pairings are colored in orange 

Over-covered This checkbox displays pairings and flights that are over-covered or have more crew members 
on the pairing than the crew complement requires. Resulting flights and pairings are colored 

in red 

Pairings This checkbox indicates if pairings will be loaded or not 

Events This checkbox indicates if events will be loaded or not 

Flights This checkbox indicates if flights will be loaded or not 

Include Cancelled This checkbox indicates if cancelled flights will be loaded or not 

Include in Gantt Displays filtered flight pucks in the Flight Gantt. 

 

Note: By leaving a field Blank in any filter panel, you are asking for all options in that field to be included. 
 

There is an option to use exclude a criterion. For example, to load all activities except for FPG pairing type, select FPG 

and then Ctrl+ Click FPG. This will turn the selection red and the results will not include FPG. 

 

Applying the Filter 

A View button is included as part of the Filter section to give the user control over when filter criteria are applied to the data 

they are viewing in the Activity Panel tabs. This allows them to make multiple modifications to filter criteria and then have 

these modifications applied to displayed data at the same time. 

 

Any changes made in the Activity Panel will require a re-filter to view them. To do this click on the View button, or to refresh 

the view of an individual tab, click on the green circular arrow on the tab. 
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Retain Layout on Refresh 

 

Filtering either on Pairings > Grid or Flights > Grid, with the Retain layout on refresh checkbox on, will keep the following 

data after a refresh: 

 

• Expanded dates; 

• Filtered values in a column; and 

• Order of data sorted in a column. 

When new dates are added to the filter and previously filtered dates are still included, all the previously loaded data will 

still be displayed with the new set of data. However, if the previously loaded dates are no longer included in the new filter, 

the previously loaded data will not be included in the display.   

 

Data loaded within the two grids will be retained if the checkbox is selected, even if one of the grids is hidden. 

 

Tab Filters 

 

Within a filtered set of data, a user may need to be filter through the results. A Search Filter is available at the top of most 

columns, which enables the user to narrow down the filter even further. For example, if you want to view certain flights, or 

equipment type, or a particular departure port, then you could click on the filter as shown in the red square below. You can 

use one of the commands on this added filter to narrow your filter results.  
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Pairings 

 

The Pairings tab displays the data associated with previously created and defined pairings. By default, pairings are grouped 

by date. Beside the date is a set of numbers that determine the number of open and actual pairings for the day.  

 

06/16/2018(1|1/1) 

 

In the example above, 1 is the number of open pairings. 1 is the number of partially or fully covered pairings. 1 is the 

number of pairings for the day. 

 

The columns in the Grid tab are detailed below: 

 

Column Description 

Date Date of the pairing  

Pairing Name of the pairing, or the pairing label 

Equip The required equipment type/s for the flights in the pairing 

Type Pairing type 

From Port where the pairing begins. This is where crew needs to report from 

Report Report time for the pairing 

To Port where the pairing ends. This is where crew will be released from 

Release Release time for the pairing 

Pair TAFB Time away from base (TAFB). This is calculated as the difference between release time of 
the last duty in the pairing and the report time of the first duty in the pairing 

Pair Flight Time Total flight time within the pairing 

Pair Duty Time Total duty time within the pairing 

Pay Credit Total pay credit for the pairing 

Open Displays the number of crew required for the pairing. The numbers are broken down per 
rank. 

Covered Displays the number of crew that are already assigned to the pairing. The numbers are 

broken down per rank. 
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Attribute Displays an attribute or a set of attributes assigned to the pairing. Attributes determine a 
specific description of the pairing such as Easy/Hard, Domestic/International, etc. These are 
set up in Configure. 

Action Set of action buttons: 

 

 Delete Pairing – click this button to delete a pairing 

 Cancel Pairing – click this to delete a pairing on initial publish or active state. This icon 

is replaced by the  Reinstate Pairing icon after a pairing is cancelled. 
 

 Allow Personal Swaps – determines if this pairing can be swapped or traded with 
another crewmember 

 

The different colours used for each flight are: 

• White signifies an open flight, or none of the operating seats have been assigned to a pairing.  

• Light blue signifies a partially covered flight, or some of the operating seats have been assigned to a pairing.  
• Orange signifies a fully covered flight, or all operating seats in the flight have been assigned to a pairing. 

• Red signifies an over-covered pairing, or there are pairings associated with one or more operational seats. 

• Grey signifies a cancelled flight. The cancelled flight icon  also appears beside the flight number. 

The Gantt tab is intended to display the flights in a Gantt view. It will be available in the future. 

 

The flight designator can be displayed or hidden by setting the user preference ShowDesignator to True or False, 

respectively, in the Configure application. Also, the IATA code for the designator is displayed by default. If the airline 

requires ICAO codes throughout the application, please contact Customer Support.  

 

Standard Pairing 

Standard Pairings are the predefined non-flight pairings that can be allocated to crew and can be assigned on any day. 

These can be assigned to any crewmember regardless of rank and equipment type. 

 

The Generic Pairings are built in the Standard Pairing tab of the Activity Panel, so you do not need to build a new pairing 

every time you need one. These have been predefined in Configure. These Generic Pairings can be inserted into a Flying 

Pairing (FPG) or assigned directly to crew in CrewPlan, CrewRoster and CrewFollow. 
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Each pairing can be configured to display a longer description when the mouse hovers on it. This makes it easier for users 

to know what each standard pairing is for.  

 

 
 

The Standard Pairings are displayed so that they can be allocated to employees in the Activity Panel, or incorporated into 

other pairings created in the Pairing Panel. It does not require the filter for pairings. All generic pairings set up in Configure 

are displayed. The pair types under the Description column are listed below. 

 

Pair Type Definition 

ADM Administration. Used for employees who will perform administrative duties in an office. Time 
spent is included in the employee’s duty time unless specified otherwise. 

ARD Airport reserve or standby. Standby time spent in the airport. Crew may be required to sign on 

at the airport. Time spent is included in the employee’s duty time whether called out or not, 
unless specified otherwise. 

AVL Available day. A placeholder in a crew’s roster that indicates that the crew is not required to 
work on this day but can be assigned work later. Time spent in this pairing may be included in 
the employee’s duty time unless specified otherwise. 

CFP Course Flight Placeholder (for Optimiser use only). This is used as a placeholder for potential 

course or training assignments. 
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DHD Deadhead. This is used for duties that have deadhead or deadhead other events only. Time 
spent in this pairing may be included in the employee’s duty time unless specified otherwise. 

FPG Flight pairing. This is the default option for pairings that have at least one operating flight. 

GRD Ground activity. Similar to administration pairings, this pairing is used for work in the airport, 
i.e. doing engine tests. Time spent is counted against duty time. 

HOL Public holiday. This is a non-work pairing and does not add any duty or flight time against the 

crew. 

OPD Obligation to Perform. OPDs is similar to an Available day (AVL) with reference to validating 
rules and utilization of preferences. Pairings such as ROE and ADD are categorized under 
this pairing type. 

RDO Rostered day off. This is a non-work pairing and does not add any duty or flight time against 
the crew. For days off rules, this is the primary pair type considered by the rule when validating 

the roster. 
 
 

RES Home reserve or standby. Standby time spent at home or in a suitable accommodation. This 
may or may not be included in the duty time of the crew, depending on the regulatory rule 

requirements.  

SIM Simulator training. This is a work pairing used to identify training or instruction in a simulator. 
Time spent is counted as duty time.  

SLV Sick leave. This is assigned to crew who call in sick or have planned medical appointments. 

SOC Subject to Operational Clearance. This is a placeholder for crew who were previously 
considered illegal or not fit to fly. Crew will only be allowed to operate once they are cleared 
by the airline. 

TRN Ground training. This is a work-pairing signifying training on ground (does not require any 

flying). Time spent is considered as duty time. 

UVL Unavailable day. This is a non-work pairing used as a placeholder for crew who are not 
available to work on the day. This is not considered as a day off, unless specified otherwise. 

VAC Vacation. This is a non-work pairing that represents a crew’s vacation or personal holiday.  

 

Flights 

The Flights tab displays the data associated with flights from the published flight schedules. By default, flights are grouped 

by date. Beside the date is a set of numbers that determine the number of open and covered flights for the day.  

 

05/06/2018(2|0/2) 

 

In the example above, 2 is the number of open flights. 0 is the number of partially or fully covered flights. 2 is the number 

of flights for the day. 
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The columns are detailed below: 

 

Column Description 

Date Date of the flight  

Flight Designator and flight number 

Equip Equipment type of the flight 

From Departure port 

Dep Departure time 

To Arrival port 

Arr Arrival time 

Onward Flight Displays succeeding flights numbers  

Flight time Difference between on chocks and off chocks 

Pair Flight Time Total flight time within the pairing 

Pair Duty Time Total duty time within the pairing 

Pair Rest Grd Time Total pay credit for the pairing 

Open Displays the number of crew required for the flight. The numbers are broken down per 
rank. 

Covered Displays the number of crew that are already assigned to the flight. The numbers are 
broken down per rank. 

Action Set of action buttons: 
 

 Flight Follow Complement Delta – Displays the complement for the selected 
flight.  

 

 Crew Assigned to Flight – Displays the operating and deadheading crew in the 
selected flight. 
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 Pairings covering the flight – Displays the pairings that has the selected flight 
included. 
 

 Flight information – Displays detailed information on the selected flight, similar 
to AircraftFollow’s Flight Information Window. 

 

The different colours used for each flight are: 

• White signifies an open flight, or none of the operating seats have been assigned to a pairing.  

• Light blue signifies a partially covered flight, or some of the operating seats have been assigned to a pairing.  
• Orange signifies a fully covered flight, or all operating seats in the flight have been assigned to a pairing. 

• Red signifies an over-covered pairing, or there are pairings associated with one or more operational seats. 

• Grey signifies a cancelled flight. The cancelled flight icon  also appears beside the flight number. 

The Gantt tab is intended to display the flights in a Gantt view. It will be available in the future. 

 

The flight designator can be displayed or hidden by setting the user preference ShowDesignator to True or False, 

respectively, in the Configure application. Also, the IATA code for the designator is displayed by default. If the airline 

requires ICAO codes throughout the application, please contact Customer Support.  

 

Events 

An event is an activity within a pairing and is not an active flight.  

 

The Events tab contains the list of previously created existing timed events which can be inserted into pairings in a similar 

way to flights. It also contains lists of the configured generic types of both timed and non-timed events that can be added 

into pairings. The Events tab also provides the functionality to allow timed events to be created that can later be inserted 

into pairings, as well as the ability to modify and delete existing timed events (for the rest of this section unless otherwise 

specified, the term event will be used to refer to existing created timed events). 
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The Events tab contains 3 main screen components or sections: 

 
1. Default Complement Grid - Defines the default complement for newly created events 

2. Generic Event Lists - Two simple scrollable lists containing timed and non-timed events 

3. Defined Events - Where the data matching the filter criteria is displayed 

Default Complement Grid 

 

This section allows the user to define the complement for any events that are created directly from this instance of the 

Activity Panel. By default when the Activity Panel is open the Default Complement Grid will default to empty. 

 

 
 

To add a complement: 

 

1. Click Add.  

2. Select a rank from the dropdown field in the Ranks column. 

3. Enter the number of crew required for the selected rank under the Req column. The changes are automatically 

saved. 
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The complement will be automatically added when a new event is created. Details of which will be discussed in the next 

sections. 

 

 
 

Generic Event Lists   

The Generic Event lists consist of two lists. The first list has all the configured timed events and the second list has all the 

configured non-timed event types within the merlot system. These events can be added into any pairing to indicate non-

flying activities that crew need to accomplish. In doing so, the user is prompted to enter any necessary information required 

to include an event of that type within the pairing.    
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Defined Events 

This is a very simple text-based grid presentation of the events that match the applied filter criteria. The columns are 

described below: 

 

Column Description 

Date Date of the flight  

Type Event type, as described in the list of timed and non-timed events 

From Departure port 

Dep Departure time 

To Arrival port 

Arr Arrival time 

Duration Length of time for the event 

Pair Flight Time Total flight time within the pairing 

Pair Duty Time Total duty time within the pairing 

Pair Rest Grd 

Time 

Total pay credit for the pairing 

Modify A button that allows users to modify details of the event 

Open Displays the number of crew required for the event. The numbers are broken down per rank. 

Covered Displays the number of crew that are already assigned to the event. The numbers are 
broken down per rank. 

 

Creating and Modifying Events 

In addition to allowing the creation of new events, a Create Event button is included. If the user has the Create security 

privilege granted to the Activity Panel – the Create Event button icon will be enabled. When a new timed event is created, 

the Create Event form is displayed to allow the entry of the information required to define a timed event.  
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The Event Form is comprised of two sections: 

 

• Event Properties - This section located on the left side of the form contains all of the specific fields required to 

detail the characteristics of the event.  

• Event Complement - This section in a grid on the right side of the form defines the number of each rank of 

crew member required for the event. If the Default Complement is set in the Events tab, it will be applied here. 

 

This form is also has Save and Cancel buttons. When Save is clicked the information entered in the form is saved into the 

event table either as new record, or as an updated existing record. Then the form is closed.   

 

When the Cancel button is clicked, the form is closed with the information entered in the form not being saved. If the 

Cancel button is clicked in the midst of dragging / inserting the timed event into a pairing, then that insertion will also be 

cancelled. 

 

When an event is being modified, the form will be populated with information about the timed event. This same event form 

is used to modify existing created timed events. To modify an event, click on the Yellow Folder under the Modify column. 

If you want to include an event into a pairing, drag it to the Pairing Panel as if you were adding a flight. 

 

The fields of the Create Event and Edit Event forms are described below: 

 

Column Description 

Label Name of the event 

Event Type Event type, as described in the list of timed and non-timed events 

From Port Departure port 

To Port  Arrival port 

Start Departure time 

End Arrival time 

Duration Length of time for the event 

Equip Equipment type if the event occurs in an aircraft (deadhead other, simulator) 
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Courses 

The Courses tab is intended to display the course instances that occur on the selected filter date range. This will be 

available in the future. 

Favorite Pairings 

The Favorite Pairings tab holds a list of pairings from the Pairings and Standard Pairings tabs marked as favorite.  

 

 
 

To include a pairing in the Favorites tab: 

 

1. Select a pairing from the Pairings or Standard Pairing tab. 

2. Click . 
The pairing will be listed under the Favorite Pairings tab. 

 

  



 

2018 | COMMERCIAL IN CONFIDENCE | Page: 32 of 79 

Pairing Details Panel 

The Pairing Details Panel is a core component of the merlot crew application as it is the only functionality that is used to 

create and modify pairings. Pairings are the key definitions of work which are assigned to crew members.  

 

There are two primary purposes that the Pairing Panel can be used for: 

 

• Creation of pairings by inserting groupings of flights and events together within a pairing 

• Modification of existing pairings by changing the duties, flights, events and complements that comprise a pairing 

 

 
 

To be able to assign work to crew members, the individual work activities need to be grouped together into meaningful 

units of work. It is the Pairing Panel that provides the functionality to group flights and events together into duties, which 

then comprise a pairing. These pairings are the units of work that can be assigned to crew members. 

 

The Pairing Panel displays the data associated with a pairing that is in the process of being created, or an existing pairing. 

To display the information about a pairing in a logical and focused manner, the Pairing Panel contains the following main 

screen components or sections: 

 

• Pairing Details - Lists the duties, flights and events that comprise the pairing, and when they commence  

• Exceptions (Tick/Cross) - Green-tick or red-cross to display pass/fail information of rules applied to the pairing 

• Assigned Crew - Contains the list of crew members who have been assigned to the pairing 

• Recurrence - The period and frequencies of the recurrence of the current pairing 

• Complement -The number and types of crew members who are required to be assigned to the pairing 

• Attributes - Additional ways to classify pairings 

 

Pairing Panel and Grid 

This section contains details of the duties and the flights and events that when combined, define the work involved within 

the pairing. It also identifies the status of a pairing, whether a pairing is a Standard Pairing or not, and the pairing version. 
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Pairing Details Panel 

 
 

Surrounding the Pairing Grid are fields and controls that provide general and configuration associated information about 

the pairing.    

 

The pairing, duty and flight/event information is displayed to the user via a scrollable grid containing three different levels 

of data. These three levels are:  

 

• Pairing: The information displayed in the grid columns relate to the whole pairing. There will only be one pairing 

level row in the grid. The pairing level row will always be the first data row in the grid.  

 

 
 

• Duty: The information displayed in the grid columns relate to the duty within the pairing. The duty is comprised of 

the flight and/or events on the subsequent grid rows up until the next duty row, or to the end of the row in the grid. 

Each duty represents the work required for one day, thus there can be one or more duty rows. For ease of 

managing the data within a pairing and allowing the user to focus on single duties at a time, the duty level is 

collapsible and expandable. 

 

 
 

• Activities consisting of Fights and Events: The information displayed in the grid columns relate to the individual 

flights or events within a duty. 

 

 



 

2018 | COMMERCIAL IN CONFIDENCE | Page: 34 of 79 

 

The columns are described below: 

 

Column Description 

Date Date of the pairing/duty/event 

Type Pairing or duty type 

Pair Name of the pairing, or pair label 

Duty Name of the duty, or duty label 

EventFlight Flight number or name of the event 

Equip Equipment type of the flight. This is blank if the event does not involve a flight 

From Departure port of the flight, or the location of the event 

ReportDep Report time of the duty, or the start time of the event 

To Arrival port of the flight, or the location of the event 

ReleaseArr Release time of the duty, or the end time of the event 

FlightTime If it is an operating flight, this holds the time from departure to arrival time. If credit flight time 
is required, it is applied in this field. The total flight time is displayed in the Duty and Pairing 
levels. 

DutyTime Duty time for each event. If credit duty time is required, it is applied in this field. The total 
duty time is displayed in the Duty and Pairing levels. 

PayCredit If pay credits are granted for the event, the value will be displayed. If you hover on the field, 

the pay credit, calculated credit and rig credit will be displayed. Pay credits are calculated and 
saved for all versions of an active pairing. 

RestGrdTime Amount of time spent on the ground when not in flight. 

TAFB Time away from base. This is the total time from report time of the first duty to the release 
time of the last duty in the pairing. 

Action These action buttons are discussed in the Pairing Actions section. 

 

Additional note for PayCredit: Trip rig credit rules can be applied to the Pay Credit column. If the pairing pay credit value 

is higher than the sum of the duties’ pay credit, the difference, referred to as X, will be used. If the pairing on the last day 

of the date range finishes on the last day, the whole pay credit value is used. Otherwise, if the last pairing ends outside of 

the date range, X will not be counted for the part of the pairing within and outside of the date range. 

 

For example, the date range is 01-30 June and the pairing on June 30 ends on 01 July with rig pay credit of 4:00 and sum 

of duty pay credit is 2:30. The difference, or X, is 1:30 or 1.5. For the date range, X will not be considered since the latest 

duty (01 July) is outside of the date range. If the date range for processing is 01 June to 31 July, X will be considered. The 

total pairing pay credits will be displayed in the Pay Credit total column. 

 

 

 



 

2018 | COMMERCIAL IN CONFIDENCE | Page: 35 of 79 

Pairing Creation 

 

The first step in creating a new pairing is to have a blank or empty Pairing Panel.  

 

Click the New button at the bottom right of the pairing panel. This will clear the Pairing Panel of the previously displayed 

pairing information and will display: 

• A single blank grid row at the pairing level in the pairing grid, and 

• A single blank grid row at the duty/flight/event level in the pairing grid. 

 

 
 

The date of the pairing you are building will initially be set at the first date defined by your Activity Filter. This can be 

amended as required to the correct date. Adding flights and events to the pairing will also adjust the date of the pairing, as 

needed. 

 

The second step is to define what is required to occur as part of the pairing. There are two different and broad types of 

pairings, each with different purposes: 

 

1. Pairings without flights/events: A definition of a period of work or non-work without any detail of what work is going 

to occur within that period. Most of the pairings of this type are Standard Pairings, for example Days Off, Vacation 

and General Administration Days. 

2. Pairings with flights/events: Pairings in which duties are defined containing the specific flights and/or events that 

determine what work is to occur during the pairing. 

 

The third step is to ensure you have the complement defined for the pairing you are building. This is discussed further in 

the next section. 
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Pairing Build 

 

There are a number of different methods available that will insert flights and/or events into a pairing. These different 

methods are provided to give flexibility in terms of how users create pairings and allow for quicker creation of pairings by 

users who are familiar with the airlines flight schedule. The methods to insert flights and/or events into a pairing are the 

following: 

 

1. Select/Drag/Drop flights from the Flights or Events tab of the Activity Panel 

2. Manually enter a date and flight number 

3. Manually enter a date and event name 

 

 
 

The above image shows dragging a flight from the Flight tab of the Activity Panel to the Pairing Panel. 
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Repair Pairings 

 

When pairings are being created or modified, they will be validated against the rules that apply to ranks included in the 

pairing. Further changes to flights or events may cause a variety of issues to be introduced into existing pairings which 

require them to be modified in order to be legal. The Repair button will essentially update the report and release times, 

flight and duty times, rest ground time, time away from base (TAFB), credit times, pay credits and the sequence of events. 

Accommodation events will also be added if an overnight is required. These updates are necessary if a flight or event is 

retimed, delayed, added or removed. 

 

 
 

Click Save. 

Save Pairings 

 

The user can save a pairing by: 

• Clicking Save; or 

• Choose the File > Save menu item. 
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Validate Pairings 

 

The Validate button validates changes as needed when creating a pairing. This is useful when the Auto Validate on 

Change checkbox is not selected. 

 

 
 

Modify Pairings 

 

An existing pairing can be changed by inserting or deleting flights and/or events from the pairing. The pairing can be loaded 

to the Pairing Panel by double clicking or dragging the pairing from the Pairing tab in the Activities panel. Flights and events 

can be added by double clicking or dragging the pairing from the Flights or Events tab, respectively. The user must click 

Save to commit the changes. 

 

Events can be modified within the pairing by clicking on the  action button. Clicking this will bring out the Edit Event 

form. 

 

Flights cannot be modified in CrewBuild. Users must modify flight information in AircraftFollow or AircraftSchedule. 

 

Cancelled flights that are still contained in a pairing are grayed out and have the cancelled flight icon  beside the flight 

number. These flights can be removed from the pairing. See the next section for instructions. 

 

Cancel Pairings 

Pairings with initial publish or active state can be cancelled. This can be done by clicking Cancel . Pairings with crew 

assigned cannot be cancelled. Users are prompted to deallocate crew from a pairing first before proceeding to cancel. 

Cancelled pairings cannot be modified or assigned.  

 

The cancellation of a pairing is reflected in the pairing version.  

 

To reinstate a cancelled pairing, click Reinstate .  
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Split Pairings 

 
The split functionality is used when a crew is required to perform an activity other than his assigned duty. 
 

The Split column in the Assigned Crew and Complement tabs allows splitting of duties and ranks. Splitting of duties with 

one assigned crew and rank complement with no assigned crew are also allowed.  

 

 
 

When splitting a complement from a pairing with no crew, the following will apply: 

 
o The selected complement will be in a separate pairing and will have the same required complement 

value 

o If a new complement is added after the split, and another split was done, the newly added complement 

will be in a separate pairing 

o When splitting all ranks, nothing will change, as it is a requirement that at least one complement remains 

with the original pairing 

o When splitting both in the Complement and Assigned Crew tabs, all the selected complements will be 

considered 

o No change will be applied when splitting a pairing with only one complement 

If there are crew assigned to a rank, the following will apply after applying a split: 

 
o The selected rank will be added to a pairing containing the same rank 

o All crew assigned to a rank will be moved to a new pairing  

o Split is not allowed if there is only one rank in the Complement tab 

o When splitting all ranks, nothing will change as it is a requirement that at least one complement will 

remain with the original pairing 

Split Pairing Functionality Applied to Actual Scenarios 

 
1. When splitting a pairing with an FO crew assigned, and there are other open rank complements i.e. CA and FA, 

the following will apply: 

a. The FO rank complement and the FO crew will be in a separate new pairing; 

b. The original pairing will drop the FO tab and the FO crew, given that they are already included in a new 

pairing; and 
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c. Changes such as adding more flights, or a deadhead assignment to the original or the new pairing will 

be allowed without affecting each other.  

 

2. When splitting a CA rank complement from a pairing with no crew assigned to it, and only open rank complements 

i.e. 1 FO 3 FA, the following will apply: 

a. The CA rank complement will be assigned to a separate new pairing with the correct number of required 

complements; 

b. The original pairing will drop the CA rank complement and will retain the FO and FA rank complements; 

c. Changes such as adding more flights, or a deadhead assignment to the original or the new pairing will 

be allowed without affecting each other.  

 

All split activities done in the Assigned Crew and Complement tabs will be reflected in the Activity Panel. 

 

Delete Events and Pairings 

 

To remove a flight or event from a pairing: 

 
1. Go to the Pairing tab. (This cannot be done on a rank tab or a crew tab). 

2. Click on the  action button on the row of the flight/event to be removed. 
3. Click Save. 

 

There are two ways to delete a pairing: 

1. From the Pairing Panel, click the  action button on the pairing level; or 

2. From the Activities Panel, click the  action button on the row of the pairing. 

 

Pairing Actions 

 

Each of the rows within the Pairing Details grid has different actions that can be performed on them dependent of the rows 

data level. The pairing action icons are as follows:  

 

 
 

Action Button Description 

 

Edit. This can be used with timed events only. 

 

Flight Information. Opens the Flight Information Window that displays flight details 

 

Flight Complement Delta – Displays the complement for the selected flight. The number of 

crew required can be adjusted from this form. Users can also apply pairing complement 
changes to flight complements in Pairing Details > Pairing tab. 
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Flight Follow Complement Delta Form 

 

The Flight Follow Complement Delta form displays and allows users to view, add, delete, save 

or cancel flight complement changes.  

 

 
 

A popup message confirming flight complement update displays when a user saves an update 

for the following: 

• Changing the Req value 

• Selecting an Augmentation Code 

• Adding a new rank complement 

• Removing a rank complement 

 

Toggle Operational/Non-operational State. Either of these icons are displayed on flights only. 
If crew is set to operate for the flight, the green icon is displayed. If crew is set to deadhead 

on the flight, the yellow icon is displayed. Click on the icon to switch between either options. 

 

Delete event. Removes the flight or event from the pairing. 

 

View History. Displays the historical changes on the event, duty or pairing. 

 

Move Up/Down. Moves an untimed event up or down. 
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Right Click Features  

 

Additional features are available to the user in the grid view, by right clicking on a selected row. 

 
 

The following options are available from the right click menu:   

Option  Description 

Add New  Allows users to add a Timed or a Non-timed event. 

Delete  Deletes an event. 

 

Other Pairing Panel Options 

 

There are more controls around the pairing grid that are essential to roster planning. 

 

These are the options at the top of the Pairing Details panel. 

 

 
 

• Status – This dropdown list has the options Planned and Active. Planned pairings are not yet available for crew 

viewing while active pairings have been published for operations and crew. Publishing a roster automatically 

changes the status to active.  

• Standard pairing selector – selecting the tick box turns the pairing to a standard pairing. 
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• Version – This dropdown list has the versions of the pairing since it was published. To view a previous version 

of the pairing, select the version and click on the […] button beside it. A prompt will appear asking if that version 

will be loaded. This is available only for pairings published from CrewRoster. 

 

These are the options at the bottom of the Pairing Details Panel. 

 

 
 

• Clear Pairing on Save? – When selected, this option clears the Pairing Details Panel after the Save button is 

clicked. 

• Refresh Activity Panel on Save? – When selected, this option refreshes all the loaded tabs of the Activity 

Panel after the Save button is clicked. 
• Load Rule Limit Summaries – When selected, automatically updates the Rule Limit Summaries whenever the 

pairing is loaded, refreshed or saved. 

• Auto Validate on Change – Automatically validates changes within a pairing. If unselected, no rule validation 

will apply when applying changes to a pairing 

• Non-connecting Flights/Events – When there are flights or events that do not match the previous arrival port 

or the next departure port, that event can be greyed out or hidden. 

• Reset All – this sets the options above to the default values. 
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Pairing Exceptions 

The Pairing Exceptions tab displays the results of rule validation for a selected pairing. It displays both pass and fail 

results for each rule.  

 

 
 

When a pairing is created or loaded, the icon on the tab changes to reflect the status of rule validation. These are 

described below: 

 

Action Button Description 

 

All rules have been satisfied. No rules have been breached. 

 

Pairings are currently being validated. 

 

There is at least one rule breach. 

 

There is at least one ignorable violation. 

 

Having the green icon for all pairings is ideal. If the red icon appears, it is best to address the issue as soon as possible to 

avoid legality issues on the day of operations. Depending on the severity and behavior of the rules that are set in Configure , 

the changes to pairings can be saved despite existing violations. 

 

Violation Icon Description 

 

Critical. The violation is causing the crew to operate illegally. It needs to be addressed 

immediately. 

 

Ignorable. This serves as a warning to the user. The crew is not yet operating illegally. 
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Critical – Override. The violation is critical but can be overridden by a supervisor or under 
captain’s discretion. 

 

Assigned Crew 

The Assigned Crew section of the Pairing Panel displays the crew who are allocated to the selected pairing. The 

allocated crew are displayed within a simple grid that is view only apart from the Action buttons. 

 

 
 

The Assigned Crew grid consists of the following columns: 

 

Column Description 

Rank The rank of the crewmember. If the crewmember is rated for two or more ranks, the rank can 
be set for that pairing from this field. 

Base Home base of the crewmember 

Name Name of the crewmember 

Roles Roles of the crewmember for the pairing, which can include Operating, Non-Operating, 
Student and Instructor 

Split The split functionality is used when a crew is required to perform an activity other than his 

assigned duty. 
 

The Split column in the Assigned Crew allows splitting of duties. For example, a crew needs 

to deadhead from YYZ to YUL before he can operate on the first flight which departs from 

YUL.  

 

Splitting of duties with one assigned crew is also allowed.  
 
To split a pairing, click on the tick box on the selected crew member’s row, then click Save. 

Action Set of action buttons: 

 

 View Pairing Allocations – opens the crewmember’s roster in the Allocation Gantt. 
This can be used in CrewPlan, CrewRoster and CrewFollow only. 
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 View Comments – opens the Comments form where public and private comments 
can be added to pairings. Public comments can be seen by crew in the employee reports 
and by users in the crew applications, while private comments can only be seen by users in 
the crew applications. 
 

 View Employee Pairing Details – Switches to the crewmember’s tab in the Pairing 
Panel  
 

 Pairing Properties – Opens the Properties tab for the crew’s pairing. This is 
displayed in the expansion below the crewmember line 
  

 Deallocate Pairing – Removes the pairing from the crewmember 
 

 

The (+) button to the left of the crewmember name displays more tabs that provide more information on the crew’s 

pairing. 

 

• Times – displays the report, release and duty times of the whole pairing (first row) and each duty (succeeding 

rows). It also displays any pay credits applied to the pairing or duty, the time away from base, standby time (if 

the crewmember was called out from standby), delay time, notified time for corresponding duty changes. All the 

fields in this tab can be modified except for Date, Pairing/Duty, DutyTime and Tafb. The Reset button will revert 

all changes back to the original values. 

 
 

• Events – Lists down all the events included in the pairing. This allows bookings to be associated to 

accommodation, deadhead and transport events. Users can declare the booking status, provider of the booking 

and the reference. This information will be relayed to the crew through the employee reports. 
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• Allowances/Expenses – Displays allowances and expenses recorded against the pairing. Manual allowances 

can be added by clicking on the New button. The allowances are added to the pairing once allowances are 

generated in CrewPayroll. 

 
 

• Seat/Roles – allows users to assign the seat and role of the crewmember for each event in the pairing. Seats 

and roles are set up in Configure. 

 
 

• Properties – allows users to assign Properties, which are characteristics of a pairing that require considerations 

on reassignment, payroll, and other operational consequences. 
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Pairing Recurrence 

The Recurrence tab allows users to create identical pairings based on a repeating pattern over a specified date range. 

 

 
 

This tab has a simple grid that allows users to specify the date range and the days of the week for the recurrence. To apply 

recurrence throughout the week, select the EveryDay checkbox. 

 

The following columns in the tab are described below: 

• From - The start date of the recurrence. 

• To - The end date of the recurrence. 

• EveryDay - Automatically applies the recurrence on all the days of the week. 

• M, T, W, T, F, S, S - The days of the week.     

 

To add a new recurrence definition to a new or existing pairing, click Add.  

 

To remove recurrence, select one or multiple rows then click Delete. 

 

Click Save in the Pairing panel to apply changes. 
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Complement 

A pairing complement is the number of crew from different ranks required to operate a pairing. By default, the pairing 

complement follows the complement of the flights in the pairing. The complement can be modified as needed. 

 

 
 

The Complement Grid is where the actual required complement of the pairing is defined.  This grid consists of the 

following columns: 

 

• Rank - The employee rank from which this pairing needs a certain number of employees allocated. This column 

will always be non-editable. 

• Req - The required number of the employees of the associated rank that are needed to operate the pairing. This 

column is always editable 

• Covered - The number of employees of the associated rank that have been allocated to this pairing.  

 This column will always be non-editable 

• Equipment Group – The type of equipment group associated with the rank.  

• Split – The split functionality is used when a crew is required to perform an activity other than his assigned duty. 

The Split column in the Complement tab allows splitting of complement ranks. Splitting of ranks with no assigned 

crew are also allowed.  

Clicking the (+) at the left of the rank expands the rank with more details similar to the Assigned Crew tab. 

 

The other elements in this tab include: 

 

• Default - This dropdown field contains active ranks where multiple selections can be done. If at least one rank is 

selected, all newly created pairings will have the selected ranks added with 0 Req.  
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• Augmentation Code - This dropdown field provides preset complements that are variations of the default 

equipment complement. These are needed for operations that require more crew. The options are set up in 

Configure. 

 

Without Augmentation Code 

 

With Augmentation Code 

 

 

• Add - Adds another row. 

• Delete - Removes the selected row. 

Changes to the Complement tab need to be saved by clicking on the Save button in the Pairing Panel. 

 

Even though there is a defined Default Complement associated with the Pairing Panel, and requirements are calculated 

from the availability of Flights / Events within the Pairing, there are a number of occasions when the user will need to modify 

the complement to something other than the default. The user can manually set or change the required value in the rows 

in the Complement Grid. To add a requirement for a particular rank that is not displayed in the Complement Grid, the user 

clicks the Add button, and selects an additional rank to be inserted into the Grid.    
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Pairing Attributes 

Attributes are additional ways to classify pairings. These are described and used the same as the attributes for employees 

or equipment types. Attributes are also used in payroll generation, rule validation and roster optimization. 

 

Multiple attributes can be assigned for each duty in a pairing by selecting the option/s from the Attributes dropdown list, 

then clicking on the Save button in the Pairing Panel. Attributes are set up in Configure. 

 

In the example below, duty C2-1-1 has the attributes LATESTART (Late Start), NACC (Non acclimatized), LAY (Layover 

pairing), FATG (Fatigue-inducing), EASY and INT (International). 

 

 
 

Pairing attributes are set up in Configure. 
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Flight Gantt 

The Flight Gantt presents flight information graphically in a bar chart format.  

 

Flights are displayed as rectangular objects, or pucks, which are aligned along a horizontal axis called the cycle line. Users 

can easily point-and-click on flights when creating or modifying pairings. 

 

The Flight Gantt has the following sections:  

 

• Zoom and expansion  

• Equipment and Cycle  

• Gantt chart 
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Zoom and Expansion 

The Zoom and Expansion section allows users to modify the view of the Flight Gantt. 

 

 
 

The buttons and links are described below: 

 

Button Description 

Zoom in and Zoom out  

Zoom in extends the Gantt chart to a wider view. Zoom 
out condenses the Gantt chart to a narrower view. 

Scroll left and Scroll right  

Moves the Gantt chart left or right, depending on the 
clicked button. 

Preset view  

 

Clicking any of these links sets the view to display flights 
within the selected range.  

 
For example, if 6 Hours is selected and the current view 
starts at 08:00, flights from 08:00 to 14:00 are displayed.  

Print  Prints out the current Gantt view. 

Expand/ Collapse Cycles

 

Expands or collapses all the cycles in the Gantt view to 

display or hide information on each flight. Expanded 
cycles reveal a middle row for a flight puck, which is 
discussed in a later section. Alternatively, click the [+] 
beside the equipment type of a cycle to expand it, and 

click [-] to collapse. 
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Equip and Cycle Columns 

Aircraft registrations displayed within the Equip and Cycle columns are read-only.  

 

 
 

The cycle number is displayed in orange text for flights that do not have aircraft registration assignments. 

 

 
 

Flights are sorted by equipment, then aircraft registration, then cycle. Results are displayed in the ascending order. 
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Users can select either to display the aircraft registration or the tail number in the Cycle column using the menu option 

below. This setting is dependent on the user preference ShowTailNumber. 

 

To view flights using aircraft registrations, click View then select Use Registration . 

 

 
 

To view flights using tail numbers, click View then select Use Tail Number . 
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Gantt Chart 

The Gantt chart displays filtered flights. All flights follow the timeline at the top. Each time the timeline moves, the flights 

move along with it. A red line that crosses from the timeline to the application footer shows the current time. 

 

 
 

The flight, also known as a sector, leg or puck, contains summarized details along with a number of graphical elements 

designed to provide users with useful information at a glance.  

 

 
 

The cycle line on which the flight sits also contains a collection of data and graphical elements which relate to the flight 

sequence rather than the specific sectors on the line.  
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Flight Colour Classification 

Flight colours change depending on the flight’s pairing coverage. 

 

Flight Colour Description 

White  
Flight is open for coverage. 

 

Orange  
Covered flight for all ranks and complements.  

 

Blue  

Partially covered flight for some ranks and complements. 

 

Red  
Flight is over-complemented. 

 

Highlighted Pairings 

Pairings are highlighted in the Flight Gantt when: 

 

• Double-clicking a pairing from the Activity Panel > Pairings tab 

• Dragging a flight from the Activity Panel > Flights tab to a pairing  

• Clicking a flight in the Pairing Details panel 

 
 

The Flight Gantt view adjusts to the highlighted pairing date accordingly.  

 

Note: Removing a flight from a highlighted pairing removes the highlight from the pairing. 

 

Find Flight 

Users can quickly find flights using the Find Flight feature. 

 

To find flights, press CTRL+F. 

 

 
 

 

 

 

Filtering Flights in the Flight Gantt 
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The Include in Gantt checkbox displays filtered flight pucks in the Flight Gantt.  

 

 
 

Note: This feature is optional. Pairings can still be created and modified using the Pairing Panel and Activity Panel. 

Utilising the Right-Click Menu in the Flight Gantt  

The following options will be displayed when accessing the right-click menu by clicking on a flight: 

 

 
 

• Open Flight Information – Displays a read-only Flight Information form.  
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• Flight Follow Complement Delta – Displays the Flight Follow Complement Delta form. Planners can modify 

information within the form. 

 
 

• Crew covering this flight – Displays the Assigned Crew form. Planners can also modify information within this 

form. 
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• Pairings covering this flight – Displays the Pairings covering this flight form.  

 
 

• Add Deadhead Other – Displays the Edit Event form. 

Selecting this option from a pairing with previously assigned events will display the following: 

 

 
 

Flights must be loaded in the Flight Gantt when adding and modifying deadhead pairings. 

 

• Deadhead – In addition to the existing behaviour when tagging a flight as deadhead, the following activities also 

tags a pairing as deadhead: 

o Adding a flight which is already covered by another pairing to another pairing.  

o Selecting Deadhead from the right-click menu, when adding a flight to another pairing which is not 

covered by another pairing. 

o Right-clicking directly on a flight and selecting Deadhead. 

o Selecting Yes, when a prompt is displayed when opening an existing pairing and left-clicking on a flight.  

Right-clicking on a space within the Gantt will only display the Add Deadhead Other option.  
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Pairings must be loaded in the Flight Gantt when adding and modifying deadhead other pairings. 

 

Users need to consider the following when creating or modifying pairings in the Flight Gantt: 

 

• To create or modify pairings, flights must be loaded first in the Flight Gantt. This is applicable to Deadhead Others 

only. 

• To create a pairing, the New button in the Pairing Details form must be clicked first 

• To modify a pairing, double-click on the existing pairing  

• Users can create or modify a pairing in the Flight Gantt as well in the Activity Panel 

Creating Pairings Using the Flight Gantt 

To create a single-day pairing in the Flight Gantt: 

 
1. When filtering flights in the Activity Panel, select the Include in Gantt checkbox to load flights in the Flight Gantt. 

2. Click New in the Pairing Details tab. 

3. Select a flight from the Flight Gantt. 

The Pairing properties were changed prompt will be displayed. 

 

 
4. Click OK. 

5. Proceed by doing the following: 

a. If the Auto Validate on Change checkbox is not selected, click Validate to validate the change; or 

b. If the Auto Validate on Change checkbox has been selected, click Save. 

Flight colours displayed in the Flight Gantt will update accordingly. 

 

Note: If the selected flight results to a fully complemented pairing, the pairing will be tagged as an operating flight. If the 

selected flight results to an over complemented pairing, the pairing will be tagged as a deadhead flight. The same process 

and results apply when creating a single-day pairing in the Activity Panel > Flights tab. 



 

2018 | COMMERCIAL IN CONFIDENCE | Page: 63 of 79 

 

To create a multi-day pairing in the Flight Gantt: 

 
1. Click New in the Pairing Details tab. 

2. Select flights from the Flight Gantt.  

 

 

In the example above, the user selected flight 853 for June 2 and flight 872 for June 3. 

 
The Pairing properties were changed prompt will be displayed. 

 

3. Click OK. 

4. Proceed by doing the following: 

a. If the Auto Validate on Change checkbox is not selected, click Validate to validate the change; or 

b. If the Auto Validate on Change checkbox has been selected, click Save. 

Flight colours displayed in the Flight Gantt will update accordingly. 

 

Removing Flights from a Pairing Using the Flight Gantt 

To remove a previously assigned flight from a pairing, load the pairing in the Pairing Panel then click on the flight and the 

Pairing properties were changed prompt will be displayed.  

 

 
 

Select Yes and the flight will be removed from the Pairing Details tab and will no longer be highlighted. 

 

Modifying Existing Pairings Using the Flight Gantt 

When modifying a pairing, load the pairing in the Pairing Panel then click on the flight. The following prompts will be 

displayed, depending on the action applied to the flight.  

 

Adding A Flight 
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Removing a Flight 
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CrewBuild Specific Tasks 

CrewBuild tasks focus on building pairings, the units of work or non-work that are 

assigned to crew members. Eventually, the completed pairings are formally published 

in CrewRoster as the official crew roster. 

 

CrewBuild tasks and workflow are outlined as follows: 

 

1. Filter for flights that you would like to create pairings for 

 

2. Group work activities (flights and events) in the Flights and Events tab in the 

Activity Panel and define the groupings. 

 

3. Group flights and events together into Duties in the Pairing Panel. 

 

4. Assign Generic and Standard Pairings to the newly created pairings in the 

Pairing Panel. 

 

5. Filter for specific flights and assign flights to the newly created pairings. 
 

 

6. Make sure the pairings are compliant by checking that the rules have passed 

as indicated by a green tick. 

 

7. Insert new events into the pairings. 

 

8. Set up recurring pairings as necessary.  

 

9. Modify pairings as necessary in the Pairing Panel.  

 

10. Repair pairings to ensure legality as changes are made 

 

11. Save pairings 

 

The next section will review the menu options in CrewBuild. 

 

 

  

CrewBuild Workflow 

 

Filter for Flights 

Group Work Activities  

 

Define Pairings – Events 

and Work 

Assign Generic &Standard 

Pairings to New Pairings 

Assign Specific Flights 

 

Evaluate pairings for 

compliance 

Set Up Recurring 

Pairings 

Modify & Repair 
Pairings  

Save Pairings 
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Menu Options 

File Menu 

The CrewBuild File menu enables users to create new pairings and to save the pairings. 

 

 

To create a new pairing select the File tab and click New Pairing from the drop-down menu. Alternatively, users can click 

on the New button from inside the Pairing Panel to start the same process.  Any old information in the Pairing Panel will 

be cleared. 

 

See the Pairing Panel section of this manual for the next steps on building pairings.  

To Save the new pairing, either select Save Pairing from the File menu, or click on the Save button in the Pairing Panel. 

To display all panels in their default sizes, click on the Reset Layout option from the File menu. 

To remove the panels from view, click on Close from the File menu. 
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View Menu 

The View menu options include: 

• Time Mode 

 
 

• Zulu (Z) - Zulu time is known as Greenwich Mean Time (GMT) 

• Port (L) -  Port time is local time in the departure or arrival port of the flight  
• Standard (S) - Standard time is local time at your company headquarters  

Tools Menu 

Important pairing related functions in CrewBuild can be accessed from the Tools menu. 

 

Delete Pairing  

To access the Delete Pairing form, select Delete Pairing from the Tools drop-down menu in CrewBuild. 

 

 
 
The steps to complete the Delete Pairing form are as follows: 

1. Select the From and To Date Time Range of the desired Pairing 
2. Select applicable Criteria (Equip Group, Rank, Base) 

3. Click OK to delete the pairing or Cancel to close the form without generating action. 

A Confirm Deletion message will display. Note the two affected pairings. 
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4. Click OK to delete the pairing or Cancel to close the form without generating action. 

 
A message will appear that the delete was successful. 

 
 

 

Repair Pairing  

The Repair Pairing feature is part of future development in CrewBuild.  There is an existing Repair Pairing feature available 

in the Pairing Panel. 

Validate Pairing  

The Validate Pairing feature is part of future development in CrewBuild.  Currently this function is a behind the scenes 

function in CrewBuild. 

Batch Validate  

The Batch Validate feature is part of future development in CrewBuild. 

 

Batch Repair 

The Batch Repair feature is part of future development in CrewBuild. 
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Update Pairing Status  

To access the Update Pairing Status form, select Update Pairing Status from the Tools menu. It is used to activate pairings 

created in CrewBuild. Pairings created in CrewBuild are by default, planned pairings. 

 

The Update Pairing Status form uses filters to locate the pairings and options within the Pairing Grid to activate the 
Pairings. 

The steps to complete the Update Pairing Status form are as follows: 

1. Select the From and To Date Time Range of the desired Pairing 
2. Select the Save Filter Dates check box to save the filter Date Time data  
 Alternatively, select an existing filter from the Filters drop down menu 

 
3. Select applicable Criteria (Base, Rank, Equip) 
4. Select All, Planned, Active or Provisionally Active from the Status drop down menu 
5. Click Apply to filter selected criteria 

The Pairing Grid on the right hand side will display the filtered results 
 

6. Select the desired Pairing type (Planned, Active or Provisionally Active) from the Update All drop down menu 
located in the bottom right of the Pairing Grid. 

7. Click the Apply button to activate the desired Pairings 
8. Click Save to save the activated Pairings or Cancel to close the form without generating action 
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Planned, Provisional and Active Pairing Status 

Planned is the default status of a pairing when you create a pairing in the period prior to publication. Planned pairings are  

visible only to users in CrewBuild, CrewRoster and CrewPlan. 

Provisionally active pairings consist of pairings or rosters that have been pre-published. These are published to the system 

as active and are viewable by all system users; however, crewmembers cannot view them in CrewPortal or CrewMobile. 

Active status refers to published pairings that system users and crew members can view in the system as live pairings or 

events. 

Transaction Mode 

Transaction Mode provides undo or "what if" capability in making a change to crew duty. If you don't like the changes you 

just made, you can simply cancel it and the duty will return to its original state. 

 
1. To start Transaction Mode, go to Tools menu and choose Transaction Mode. 

2. Once selected, you will notice TRANSACTION MODE will appear in red color on the title bar, meaning you're in the 

Transaction Mode. 

3. Once you are in Transaction Mode, you can make changes without risk to commit to these changes.  When you are 

finished you can choose to Save it or Cancel these changes. 

 

These three menu commands are related to each other: 

 

• Transaction Mode/Immediate Save Mode – Switches between Transaction Mode and back to Immediate Save 

Mode. Immediate Save Mode is the regular and default mode of the application. 

• Save/Commit Transaction – Saves the changes made in transaction mode 

• Cancel Transaction – Discards all modifications made in transaction mode 

 

Export Pairing Files 

This option allows users to export pairings into an XML file that can be used by a third party program.  

 

 
 

To export pairings: 

 
1. Select the date range by entering it in the From and To fields. 

2. Select the required operator. Keeping this field blank will export pairings for all active operators. Multiple 

operators can be selected. 



 

2018 | COMMERCIAL IN CONFIDENCE | Page: 71 of 79 

3. Select the required base. Keeping this field blank will export pairings for all active bases. Multiple bases can be 

selected. 

4. Select the required rank. Keeping this field blank will export pairings for all active ranks. Multiple ranks can be 

selected. 

5. Click the Export button.  

The export file will be placed at the location configured in the OptimisationXMLExportJob. 

Import Pairing Files 

The Import Pairing files form allows the user to import a pairing XML file produced by the merlot.aero Optimiser Suite.   

 

 

To import a pairing file:    

 
1. Provide a name for the solution in the Name field. For example, JUL2015 CPT. 

2. Select the file by clicking on the Browse button. Once the file is selected, click the Open button.  
3. Click the Import button to import the XML file or the Cancel button to close the form without generating action 
4. Click Yes on the Confirm action dialog box, after confirming the requested information is correct, or click No to 

cancel the request and close the dialog box without action 

5. You will receive a message once the file has been imported. From this point, pairings can be filtered in the 
Activities Panel.   

Delete Pairing Recurrence  

The Delete Pairing Recurrence form is used to delete recurred pairings. This is commonly used when the flight schedule 

changes after pairings have been created. 

 

 
 
To complete the Delete Pairing Recurrences form:    

1. Select From and To dates of the recurred pairings.  
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2. Click OK to delete pairing recurrences or Cancel to close the form without generating action 

A message will indicate that pairings for the specified date range have been successfully deleted. 

 

In terms of best practices, pairing recurrences that are no longer needed, should be deleted prior to roster publishing. 
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Reports  

To view Reports within CrewBuild, select the Reports Tab and choose a report from the drop-down menu. 

  

 
 

Pairing Details Report  
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Pairing Summary Report  

 
 

These reports can be customized to meet specific customer requirements. 
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Application Flow Diagram 

  

 

Configure application is a central place where all crew and aircraft configuration information can be 

accessed. The application defines the core set of configuration requirements that are the building 

blocks that allow merlot applications to be used in the way required by your airline.  

AircraftSchedule improves the development of flight schedules while ensuring operational integrity  

and meeting the needs of airlines for increased efficiency in scheduling. The application includes a 

maintenance planning capability. 

CrewBuild develops efficient crew pairings that achieve business goals while meeting the needs of 

crew and managing changes that arise after the roster is published. 

CrewPlan plans and monitors all revalidation and qualification checks, medicals, license renewals ,  

annual leave and administrative needs. Crew shortfalls or surplus information is accurately  

calculated by fleet, rank or base and can be aggregated at daily, weekly or monthly levels. This  

extends to future establishment planning. 

The CrewRoster application allows the user to develop efficient crew rosters that achieve business 

goals while meeting the needs of crew.  

CrewFollow provides airlines with the best information to act on in response to crew disruptions 

resulting from (amongst other things) sickness, no-shows and crew-related disruptions on the day. 

CrewMonitor identifies and monitors changes within merlot for disruptions that will impact pairings 

and pairing allocations to crew members. 

CrewPortal and CrewMobile provide airline crew with the ability to view the latest crew related 

information on a computer or mobile device such as phones or tablets. It enables airline operations 

employees to securely distribute timely and relevant information to crew members including duty  

assignments, duty changes and messages. 

AircraftFollow provides a real time graphical representation of your airline’s live status for the day.  

AircraftFollow allows the user to manage incoming and outgoing aircraft and related operational 

tasks on a day-to-day basis. The application provides accurate and timely information to improve 

the decision support process. 

AircraftPortal and AircraftMobile provide outstations with the ability to view the latest schedules and 

fight-related information on a computer or mobile device. Updates to departure and arrival times, 

terminals, gates and bays can be done from here. These also allow management a quick look at  

the day’s operations. 

 

CrewPayroll manages complex pay and allowance calculations for crew.  

The ExecutiveDashboard provides executive level reporting including key performance indicator 

(KPI) data to help airlines gauge operational and employee success.  

Configure 

 

AircraftSchedule 

 

CrewBuild 

 

CrewPlan 

CrewRoster 

CrewFollow  

 

CrewMonitor 

CrewPortal, 

CrewMobile 

AircraftFollow 

AircraftPortal, 

AircraftMobile 

CrewPayroll 

ExecutiveDashboard 
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CrewBuild Glossary  

Duty Term 

AOC 

Air Operator's Certificate 

Also referred to as Operator or Operator Code 

 

The AOC is the approval granted by a national aviation authority (NAA) to an aircraft 

operator to allow it to use aircraft for commercial purposes. This requires the operator to 

have personnel, assets and system in place to ensure the safety of its employees and the 

general public. 

Base The port to which crewmembers are expected to commence and finish their tasks / activities. 

Block Hour 

Also called block time, blocks or flight hours 

 

The time from the moment the aircraft door closes at departure of a flight until the moment the 

aircraft door opens at the arrival gate following its landing. Block hours are the industry 

standard measure of aircraft utilization. Many airlines consider a block hour to be from the time 

the chocks are removed from the wheels of a departing aircraft, after doors have been closed, 

until the time the chocks are put in place at the wheels after arrival at the airport gate before 

the doors are opened. 

Broken Pairing 

A pairing that has any of the following characteristics: 

• does not return to its start location; 

• has events that conflict with the previous or next event's port; or 

• has overlapping events within it. 

Note that there are other types of exceptions that indicate problem pairings, but these are 

broken in terms of structure rather than rule limits. 

Company Pairing 

Also called Generic Pairing, Ground Pairing, Non-flight Pairing, Standard Pairing 

 

These are pre-defined non-flight pairings that can be allocated to crew. Examples of these 

are: Administration Days, Days Off, Annual Leave and Sick Leave. Also known as Standard 

Pairing or Generic Pairing. 

Company Time This refers to the time at which the pairing or event is occurring converted to the company’s 

base or headquarters location 

Covered Pairing A pairing that has all complements filled. 

Crew A specific type of employee required for flight operations. This term is interchangeable with 

employee. 

Crew 

Complement 

The number and types of crew required for a pairing. 

Crew Flow The sequence of flights and events contained within a crew's duty. This may or may not be 

aligned to aircraft sequence. 

Department The areas within an airline or company that are tasked with providing particular services of a 

similar type. For example, in an airline there are Flight Operations (i.e. the manning and 

operating of aircraft), Maintenance (ensure the aircraft were able to operate safely), and Ramp 

(the parking and coordination of aircraft resupply between flights). 

Designator Unique alphanumeric code given to distinguish each airline, or operations within an airline 

Duty A grouping of flights and / or activities that can be performed legally by a crew member during 

one work period.  One or more duties combined together define a pairing. 

Employee The generic term for people who are trained to perform specific tasks/activities. Within Flight 

Operations, the employees are generally referred to as crew or crewmembers; and within 

Maintenance, the employees are generally referred to as engineers, mechanics, avionic 

technicians etc. 
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Equip Config Each equipment type can have more than one configuration for seats and cargo. This will 

affect the assignment of flights to aircraft rego/tails. 

Equipment Group The grouping of a similar set of equipment types. For example, a 737 which could be 

comprised of 733 and 734 equipment types. 

 

This can also be used as a reference to indicate the equipment types that a crewmember is 

legal to operate on as part of his rating. 

Equipment Type Also called aircraft type. 

 

Model of the aircraft. A specific type of aircraft that has distinct characteristics, for example a 

733 or 734. 

 

This can also be used as a reference to indicate the equipment types that a crewmember is 

legal to operate on as part of his rating. 

Flight Also called sector 

 

The transport taken from a departure point to an arrival point. 

Flight 

Complement 

The number and types of crew required to operate a flight. 

Flight instance A specific flight on a specific date. This term is used for flights that are recurred through a 

specified period. 

Flight Pairing A pairing that contains at least one operating flight. 

GMT Greenwich Mean Time 

Also called Zulu time 

 

The time at location at which the pairing or event is occurring converted to Greenwich Mean 

Time (GMT) value. 

Ground Pairing A pairing that contains only ground activities. No operating or deadheading flights are included.  

Local Time The time at the location at which the pairing or event is occurring. If the location is the same 

or in the same time zone as the company base or headquarters location this time will be the 

same as the company value. 

Open Pairing A pairing that has at least one complement still requiring a crew member to be assigned. 

Open Sector Also called unpaired flight 

 

A flight that has not been assigned to a pairing. 

Paired Flight A flight that has been added or assigned to a pairing. 

Pairing The generic unit of work and non-work that can be assigned to a crew member. A pairing is 

comprised of none, one or more flights and/or activities grouped together into one or more 

duties. A pairing may span over multiple days. One or more duties combined together define 

a pairing. 

 

A pairing is from home base to home base so it can encompass a number of duties each with 

individual report and release times. In this way pairings can span a single or multiple days. 

Pairings are usually built for all crew that carry out identical work. For instance the Captain, 

the First Officer and the Flight Attendants, who all stay together, will be on the same pairing. 

To ensure consistency and simplicity of allocation a Pairing will be the only unit of activity that 

can be assigned to a crew member. There are some exceptions to this but in general this 

concept applies across the suite of applications. 

Pairing 

Complement 

The required number of employees of each rank that are needed to fully operate that pairing. 

Port An airport or station 

Rank The core qualification that an employee holds which defines the level/type of tasks and 

activities they can perform. For example Captain, First Officer, Flight Attendant. 
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Rating (or Type 

Rating) 

Defines the combination of equipment and position that personnel can legally operate. In 

merlot, the characteristics that define a rating are: Rank, and Equipment Group. 

RDO Rostered Day Off  

 

A day in a roster period that an employee doesn't have to work. An employee's day off can be 

paid or unpaid, depending on how RDOs are set out in an award or registered agreement. 

Recurrent flight A flight that operates the same flight number, route and timings on more than one day 

Roster A roster is simply a defined period of time within which the crew member’s work and non-work 

assignments are defined. 

Turnaround Also called Actual Turnaround, Scheduled Turnaround, Turnaround Time 

 

Amount of time between the arrival of a flight and its departure from a port. This is also the 

time taken to unload passengers, baggage, cargo, etc. upon arrival and to board passengers 

and load baggage, cargo, etc. before departure 

Violation 

Behavior 

This determines what can be done to a violation once it is flagged. This works in conjunction 

with violation severity. 

• Inviolate - does not allow the assignment to push through no matter what 

• Override - if the user has the appropriate security rights, he can override the violation 

• Override Disrupt - if the user has the appropriate security rights, he can override the 

violation only if the flight is in disrupt 

• Track - the user can proceed with the roster changes but the violation is retained for 

tracking purposes. The violation will not have a pop up, but will be visible in the 

Violation Panel. 

• Ignore - the violations are retained in the Violation Panel 

Violation Override This determines how a violation should be overridden 

• Management - the credentials of a management-level user must supply his 

credentials when overriding the violation 

• Supervisor - a supervisor must supply his credentials when overriding the violation 

• Extension - a user with override rights must supply his credentials when overriding 

the violation which consequentially allows an extension to the flight hours, duty hours 

and/or flight duty period 

• Discretion - signifies that the violation will be overridden based on the captain's 

discretion 

Violation Severity This determines how a violation is presented 

• Critical - the violation must be addressed. Otherwise, the crew is illegal to fly 

• Ignorable - the violation can be addressed later and will not prevent the crew from 

reporting for a duty 

• Informational - the rule breach is for informational purposes only 

• Passed - the rule is not breached and nothing has to be done 
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Notes 

 

  

 


